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COPYRIGHT NOTICE 

Copyright 2004 ArWest Communications Corp.  All rights reserved. 
No part of this publication or the computer programs described 
herein may be reproduced, translated, stored in a retrieval system, 
or transmitted in any form or by any means, electronic, mechanical 
photocopying, recording or otherwise, without prior written permis-
sion of ArWest Communications Corp.  Your rights with regard to this 
publication and the computer programs are subject to the restric-
tions and limitations imposed by the copyright laws of the United 
States of America (“U.S.A.”) and/or the jurisdiction in which you are 
located.  For information on translations and distribution outside the 
U.S.A., please contact ArWest Communications. 
 
Printed in the United States of America 
Part Number: UF-00001-100 
March 05 
 

TRADEMARK NOTICE 

ArWest is the registered trademark of ArWest Communications Corp.  
AlphaWave, AW and AWare are trademarks of ArWest Communica-
tions Corp.  All other product and brand names are trademarks or 
registered trademarks of their respective holders. 
 

SOFTWARE LICENSING AGREEMENT 

IMPORTANT: BY OPENING THE SEALED DISK PACKAGE CONTAINING THE SOFT-

WARE MEDIA OR INSTALLING THE SOFTWARE YOU ARE AGREEING TO BE BOUND 
BY THE TERMS AND CONDITIONS OF THE LICENSE AGREEMENT (‘AGREEMENT’).  
THIS AGREEMENT CONSTITUTES THE COMPLETE AGREEMENT BETWEEN YOU 
(‘LICENSEE’) AND ARWEST (‘LICENSOR’).  CAREFULLY READ THE AGREEMENT 
AND IF YOU DO NOT AGREE WITH THE TERMS RETURN THIS UBPOPENED DISK 
PACKAGE AND THE ACCOMPANYING ITEMS TO THE PLACE WHERE YOU OBTAINED 
THEM. 
 
LICENSE: LICENSOR grants you a limited, non-exclusive, non-
transferable, personal license (‘License’) to (i) install and operate the 
copy of the computer program contained in this package (‘Program’) 
in machine acceptable form only on a single computer (one central 
processing unit and associated monitor and keyboard) and (ii) make 
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one archival copy of the Program for use with the same computer.  
LICENSOR and its third-party suppliers retain all rights to Program 
not expressly granted in this Agreement. 
 
OWNERSHIP OF PROGRAMS AND COPIES.  This License is not a sale 
of the original Program or any copies.  LICENSOR and its third-party 
suppliers retain the ownership of the Program and all copyrights and 
other propriety rights therein, and all subsequent copies of the Pro-
gram made by you, regardless of the form in which the copies may 
exist...  The Program and the accompanying manuals 
(‘Documentation’) are copyrighted works of authorship and contain 
valuable trade secret and confidential information propriety to LI-
CENSOR and its third-party suppliers.  You agree to exercise reason-
able efforts to protect the proprietary interests of the LICENSOR and 
its third-party suppliers in the Program and Documentation and 
maintain them in strict confidence. 
 
USER-RESTRICTIONS.  The Program is provided for use in your in-
ternal commercial business operations and must remain at all times 
upon a single computer owned or leased by you.  You may physically 
transfer the program from one computer to another provided that 
the Program is operated only on one computer at a time.  You may 
not operate the Program in a time-sharing or service bureau opera-
tion or rent, lease, sublease, sell, assign, pledge, transfer, transmit 
electronically or otherwise dispose of the Program or Documentation, 
on a temporary or permanent basis, without prior written consent of 
LICENSOR.  You agree not to translate, modify, adapt, disassemble, 
decompile, or reverse engineer the program, or create derivative 
works of the Program or Documentation or any portion thereof. 
 
TERMINATION.  The License is effective until terminated.  The Li-
cense will terminate without notice from LICENSOR if you fail to 
comply with any of the provisions of this Agreement.  Upon termina-
tion, you must cease all use of the Program and Documentation and 
return them and any copies thereof to LICENSOR. 
 
GENERAL.  This Agreement shall be governed by and construed in 
accordance with the Laws of the State of California and the United 
States of America without regard to conflict of laws provisions 
thereof and without regard to the United Nations Convention on Con-
tracts for the International Sale of Goods. 
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DISCLAIMER OF WARRANTIES AND LIMITATIONS OF LIABILITY 

LICENSOR AND ITS THIRD-PARTY SUPPLIERS MAKE NO WARRANTIES OR REPRE-

SANTATIONS, EXPRESS OR IMPLIED, REGARDING THE PROGRAM, MEDIA, DOCU-

MENTATION, RESULTS OR ACCURACY OF DATA AND HEREBY EXPRESSLY DISCLAIM 
ANY WARRANTIES OF MERCHANTABILITY AND FITNESS FOR PARTICULAR PURPOSE 
AND NONFRINGEMENT.  LECENSOR AND ITS THIRD-PARTY SUPPLIERS DO NOT 
WARRANT THE PROGRAM WILLMEET YOUR REQUIREMENTS OR THAT IT’S OPERA-

TION WILL BE UNINTERRUPTED OR ERROR-FREE. 
 
LICENSOR, its third-party suppliers, or anyone involved in the crea-
tion or delivery of the Program or Documentation to you shall have 
no liability to you or any third-party for special, incidental, indirect or 
consequential damages (including, but not limited to, loss of profits 
or savings, downtime, damage to or replacement of equipment or 
property, or recover or replacement of programs or data) arising 
from claims based in warranty, contract, tort (including negligence), 
strict liability, or otherwise even if LICENSOR or its third-party sup-
pliers have been advised of the possibility of such claim or damages.  
The liability of the LICENSOR and its third-party suppliers for direct 
damages shall not exceed the actual amount paid for this Program 
License. 
 
Some states do not allow the exclusion of limitation of implied war-
ranties or liability for incidental or consequential damages, so the 
above limitations may not apply to you. 
 

U.S. GOVERNMENT RESTRICTED RIGHTS 

The Program and Documentation are provided with RESTRICTIVE 
RIGHTS.  Use, duplication, or disclosure by the Government is sub-
ject to restrictions as set forth in subdivision ©(1)(ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-
7013 or subdivision 9©(1) and (2) of the Commercial Computer 
Software – Restricted Rights 48 CFR 52.227.19 as applicable. 
 
Should you have any questions concerning the Limited warranties 
and Limitation of Liability, please contact in writing: ArWest Commu-
nications Corp. 300 Orchard City Drive, Suite#126, Campbell, CA 
95008, USA 
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EMISSIONS 

FCC    FCC Part 90 
ETSI    300-113 
Industry Canada  RSS-119 
 

NOTICE 

Changes or modifications not expressly approved by ArWest Com-
munications Corporation could void the user’s authority to operate 
this equipment. 
 
Shielded cable must be used with this equipment in order to ensure 
that it meets the emissions limits for which it was designed.   It is 
the responsibility of the user to obtain and use good quality shielded 
cables with this device.  Shielded cables are available from most re-
tail and commercial suppliers of cables designed to work with radio 
equipment and personal computer peripherals. 
 

406.0 TO 406.1 MHZ OPERATION 

The frequency band from 406.0 to 406.1 MHz is reserved for use by 
distress beacons.  As such AW400 should not be programmed to 
transmit on any frequency within this band.  Caution should be used 
when programming frequencies into the AW400 to eliminate the pos-
sibility of AW400 users interfering with rescue operations in this 
band (US only). 
 

SAFETY WARNING 

In order to ensure the safe operation of this radio equipment, the 
following practices should be observed. 
 
DO NOT operate radio equipment near electrical blasting caps or in an 
explosive atmosphere 
 
DO NOT operate any radio transmitter unless all RF connectors are 
secure and any open connectors are properly terminated. 
 

DO NOT allow the antenna to come close to, or touch, the eyes, face, 
or any exposed body parts while the radio is transmitting. 
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1. INTRODUCTION        

1.1 WHAT IS THE ALPHAWAVE (AW) SYSTEM  

AlphaWave (AW) is a wireless system operating in the frequency 
band (50 to 800 MHz) that provides advanced features without com-
plicated system set up, it includes: 
 

• AW Radio Modem; 
• “AWare” - Windows based Unit Configuration and Mainte-

nance Software Application running on a IBM PC compatible 
computer (Distributor and User version) “Pocket AWare”- Unit 
Configuration and Maintenance Software Application running 
on a PDA (Personal Digital Assistant).  

 
 

 
              

 
 
 
 
 
 
 

Figure 1-1: AW Transceiver 

The AW programmable, transparent radio modems provide real-time 
data transmission using spectrum efficient PSK/QAM modulation. It 
delivers error-free data at up to 38.4 kbps over the air for the 25 
kHz channel spacing, 19.2 kbps for 12.5 kHz, and 9.6 kbps for 6.25 
kHz. 
 
The two ports on the AW provide access to set up and test without 
unplugging the application terminal device. The setting can be done 
through the built-in Command Line interface (CLI), or through the 
configuration and maintenance application software running either 
on a PC – “AWare” or on PDA – “Pocket AWare”. 
The diagnostic feature of the AW system provides information to 
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monitor and maintain the user’s communications link. The output 
transmit power, receive signal strength (RSSI), antenna/feedline 
condition, and data decode performance will be transmitted online 
without application interruption. 
 
The product is designed for maximum performance and reliability 
even in the harshest environments. Plug and play at its best, robust, 
withstanding the most adverse of conditions. With up to 2 watts RF 
output the AW system offers the most popular features required for  
telemetry and SCADA systems. 
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Parameter Specification 
Operating Frequency Range 150-170, 220-235, 403–470 MHz 
Modulation Techniques DBPSK, DQPSK, D8PSK, and D16QAM 

Radio Protocol 
Time Division Duplex (TDD) 
Time Division Multiple Access (TDMA) 

Max. Distance Range 50 miles / 80 km 
Occupied Bandwidth (Channel 
Spacing, CS) 25 kHz, 12.5 kHz or 6.25 kHz 

Data Rate (BPS) 25 kHz  
CS 

12.5 kHz  
CS 

6.25 kHz  
CS 

GMSK/DBPSK 
DQPSK 
D8PSK 

D16QAM 

9600 
19200 
28800 
38400 

4800 
9600 
19200 
28800 

2400 
4800 
7200 
9600 

System Gain   
(Ant gain not included) 146 dB 149 dB 152 dB 
Roaming Speed 60 mph / 96 km/h 
End to End delay 50 ms 

Table 1-2:     AlphaWave General Radio Specifications 
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Parameter Specification 
Operating Voltage +9….+24 VDC nominal 
Pwr Consumption (avg) 6W / 2W / 0.05W – Transmit / Receive / Sleep 
Operating Temp Range -30oC…..+60oC 
Dimensions (H x W x D) 5.87 in x 2.93 in x 1.51 in / 137 mm x 67 mm x 29 mm 
Weight 12 oz / 340 g 
Color/Housing Two-tone Silver/Graphite, Aluminum Housing 
Antenna Connector TNC, 50Ω, female 
RS232 Connector D15 waterproof female connector 

Table 1-1:     AlphaWave Physical Specifications 



1.1.1  MODEL NUMBERS 

The AlphaWave naming protocol utilizes a two (2) letter prefix AW 
and a three (3) character suffix to identify which part of the fre-
quency range the particular transceiver operates on 
 
AW100 150 to 170 MHz 
AW200 220 to 235 MHz 
AW400 403 to 470 MHz 

1.1.2  NETWORK TOPOLOGIES 

The AW Radio Modem supports Point-to-Point link (PTP) using Time 
Division Duplex (TDD) protocol and Point-to-Multipoint (PMP) net-
work topology using Time Division Multiple Access (TDMA) protocol. 
The wireless media access contention for the PMP network can be 
resolved by an external controller through the data interface control 
lines (RTS, CTS, DTR, DSR, and DCD). In addition, the following ver-
sions of the AW software/firmware offer built-in Media Access Con-
trol (MAC) protocols to service PMP network. 

1.1.3  OPERATING MODES 

AW operating modes can be set through the CLI or through the ex-
ternal management application software. The following operating 
modes are available for the AW radio modem: 
 

• Half duplex operating provides up to 9.6/19.2/38.4 kbps user 
data throughput. The “Transceiver” and “Repeater” are the 
alternative protocols for the half duplex operation. 

• Full duplex mode, with up to 4.8/9.6/19.2 kbps user data 
throughput, is an alternative to the default half duplex. 

• Sleep mode has automatic transmitter activation by an inter-
nal real-time clock, or by an external controller through the 
data interface control lines (RTS and DTR), or by the trigger-
ing of the external Sense Inputs. 

• Programmable automatic channel scanning of the Preferred 
Channels is an alternative mode to the operation on the fixed 
Frequency Channel. 

• “Test” mode supports the radio installation using Built-in test 
tools. 

           Page 1-3 

AlphaWave Users Manual                                    3/21/2005 

C
h

apter 1 



1.1.4  MANAGEMENT TOOLS 

The built-in management tools along with “AWare” and “Pocket 
AWare” configuration and monitoring software applications provide 
the following benefits: 
 

• Easy user’s interface for system configuration and monitoring 
using well developed CLI or intuitive GUI. 

• An ability to test the link using built-in test utilities without 
expensive external test equipment such as spectrum analyzer 
and BER test analyzer. 

• An ability to monitor status, alarms and radio performance 
through the intuitive GUI. 

• Software upgrades and improvements can be downloaded 
from “AWare” or “Pocket AWare” to the units connected with 
PC/PDA locally or remotely, through the wireless link. 

1.2 ITEMS SUPPLIED WITH AW 

Provided with each system is a transceiver (AW100, AW200, 
AW300), serial interface cable and a CD.  The CD includes Windows 
PC Interface Software – AWare, Windows CE Interface Software 
Pocket AWare a slide show for familiarization with AWare and a set 
of sample configurations. 

1.2.1 AW TRANSCEIVER 

 

 

Figure 1-2: AW Transceiver – Interface Connector   

 

 

 

 

Figure 1-3: AW Transceiver – Antenna Connector 
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Figure 1-4: AW Transceiver – Side View LEDs 

 
 

 

 

 

 

Figure 1-5: AW Transceiver – Top View 

1.2.2 AW INTERFACE CABLE 

Included with each system is a 2 meter interface cable for program-
ming purposes only—THIS IS NOT A FIELD CABLE. 

DB15 pin for the AlphaWave with a DB9 for connection to a PC/CE 
Device for configuration, field use, etc. and two tinned cables for 
connection to an external power supply. 

           Page 1-5 

AlphaWave Users Manual                                    3/21/2005 

Figure 1-6: DB15 Connector 
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The serial Data Interface can be configured through the software to 
operate in half and full duplex operating modes. The serial line Data 
Rate should also be under the software control, which provides the 
automatic data rate detection. 
 
RTS, CTS, DSR, DTR and CD signals should be reserved on-board for 
future support of full RS-232 hardware handshake operation. This 
will provide the support of the wide range of different standard and 
none-standard, user specific, Data Link interfaces. 
 
The serial interface is protected against static discharge (15 kV) and 
shorts with power and signal circuits. 

1.2.3  ALARM/SENSE INTERFACE 

The Alarm/Sense Interface provides two external sense CMOS/TTL 
input lines and two TTL output lines for connection to external Alarm 
and Security systems. 
 
The TTL output lines can be configured to indicate the following 
alarms: 
 

Connector  
Pin # 

Signal 
Name 

Signal Description Signal 
Type 

1 DCD Data Carrier Detect O 
2 DSR Data Set Ready O 
3 RTS Request To Send I 
4 TX Data from PC Serial Port to Modem I 
5 MP TX Maintenance Port Serial Data In I 
6 TTLIN2 TTL In 2 I 
7 TTLIN1 TTL In 1 I 
8 PWRIN DC Power between 9 and 24 VDC DC 
9 DTR Data Terminal Ready I 
10 CTS Clear To Send O 
11 RX Data from Modem to PC Serial Port O 
12 MP_RX Maintenance Port Serial Data Out O 
13 TTLOUT2 TTL Out 2 O 
14 TTLOUT1 TTL Out 1 O 
15 GND DC Power and Signal to Ground I 

Table 1-3:     Standard External Connector Pin Layout  
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1.2.4  SERIAL MAINTENANCE INTERFACE 

The serial asynchronous interface allows connection to external se-
rial devices. All commonly supported baud rates, parity and bit con-
figurations are available up to 115.2 kbps. This interface is a simple 
3-wire with RS-232C signal levels. The serial interface is protected 
against static discharge (15 kV) and shorts with power and signal 
circuits. 

1.2.5  LINK ALARM/STATUS INDICATORS 

External LED's are used for Link and Line status indication: 
  

 
1.2.6  POWER INTERFACE 

The power interface allows connection to an unregulated DC power 
source. The DC power source (third-party or user supplied) must 
provide a minimum of 11.0 Watts of DC power between 9 and 
24VDC.  The power interface is protected against reverse polarity 
connection, as well as protected against high-voltage transients. 

TTL_OUT1: TTL_IN1 (received from remote unit) 
TTL_IN1 and TTL_IN2 (received from remote unit) 
TTL_IN1 or TTL_IN2 (received from remote unit) 

TTL_OUT2: TTL_IN2 (received from remote unit) 
BER >10 –3 or SYNC Loss 
BER >10 –4 or SYNC Loss 
SYNC Loss 

Table 1-4:     TTL Output Lines 

Pos’n Led  
Name 

Color 
Description 

1 Power Green Active if Power connected to modem 

2 Link Red Active whenever a signal with a level exceeding 
the level required for reception exists on the 
radio channel (min. light on 200ms). 

3 Rx/Tx Green Active if  modem receives or transmits Data 
over serial interface (min. light on 200ms) 

4 Alarm Red Alarm indicator 

Table 1-5:     External LEDs 
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1.2.7  RF INTERFACE 

The stand-lone unit’s RF interface is a 50-ohm impedance matched 
standard BNC/TNC connector as required by regulations. The RF in-
terface can operate without damage to the unit under DC short and 
open conditions. 

1.2.8  ANTENNAS 

Antenna type depends on the site requirements, and may be direc-
tional or omni-directional. The AW Base antenna is typically mounted 
on a mast that elevates the antenna a minimum of 40 feet above the 
average level of the terrain to support 50 miles distance range. 
 
The total system gain allowable includes both the Radio-Modem and 
the antenna.  The table listed below is for ArWest antennas, however 
the Gain values can be used with other antennas to determine Al-
phaWave Power Setting. 
 
 

 
 
 
 
 
 
 
 
 
 

 
Warning: 
1. The values defined in the table must not be exceeded in order 
 to ensure compliance with RF exposure regulations. 
2. The antenna must be installed so as to ensure a separation 
 distance of at least 20 cm from all persons. 
3. The antenna of the device may not be co-located or operating 
 In conjunction with any other antenna or transmitter. 
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Antenna Part#  
Gain 
(dBi) 

AlphaWave 
Power Setting  

ERP 

AT-30000 to AT30005 0 33 dBm (2W)  1.22W 
AT-30006 to AT-30007 3 30 dBm (1W) 0.61W 
AT-30008 to AT-30010 5 28 dBm (0.63W) 0.385W 
AT-30011 to AT 30015 9 24 dBm (0.25W) 0.153W 
AT-30016 8.8 24.2 dBm (0.263W) 0.128W 
AT-30017 to AT-30018 9 24 dBm (0.25W) 0.153W 

Table 1-6: AlphaWave Power Settings v Antenna  
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2. CONFIGURE YOUR ALPHA-WAVE        

All AW products are shipped as Remote units with SmartScan© and 
Plug-and-Play enabled. 

2.1 PLUG AND PLAY (DEFAULT SETTING) 

Simply connect the antenna and apply power to an AW unit that has 
the same Channel Mapping as the Base unit and SmartScan© tech-
nology will immediately detect the Base Station frequency and pro-
tocol and start receiving data. 

2.2 BASE SETUP 

Use AWare “Link Protocol Properties Tab” (Figure 5-4) to convert the 
default “Remote” settings to the Base settings.  On completion of 
setting Base in the Protocol Properties ensure that the correct Proto-
col Option is then selected (Simplex Transmitter/Primary Trans-
ceiver/Full Duplex). 

2.3 REMOTE SETUP 

All AW Products are shipped as Remote units, to return a unit recon-
figured as a Base or Repeater to the Remote Mode, use AWare “Link 
Protocol Properties Tab” (Figure 5-4) to convert the default “Remote” 
settings to the Base settings.  On completion of setting Base in the 
Protocol Properties ensure that the correct Protocol Option is then 
selected (Simplex Receiver/Secondary Transceiver/Full Duplex). 

2.4 REPEATER SETUP 

Use AWare “Link Protocol Properties Tab” (Figure 5-4) to convert the 
default “Remote” settings to the Repeater settings. 

2.5 INSTALL NEW FIRMWARE 

To install new firmware in an AW unit section 6.4 covers the 
downloading of the “embedded software images” using AWare. 
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3.  AWARE - GENERAL DESCRIPTION 

AWare is a MS Windows® based software program designed for con-
figuring and maintaining ArWest UHF radio systems. AWare is a 
user-friendly software application that provides complete and power-
ful tools for radio monitoring and diagnostics. It also provides soft-
ware image and configuration downloading. The statistics from the 
monitoring can be viewed in text or graphical format. With the sup-
port of ArWest radios’ real-time software, AWare architecture makes 
it possible to maintain all wireless network radio configuration by 
connecting to only one unit.  

 
The program consists of three panes. The left pane shows the list of 
units in the wireless link/cluster. In the root node of the tree there is 
a local unit that is directly connected, through a serial cable, to the 
management computer running AWare. The right pane is the main 
window, which displays the selected unit’s main configuration pa-
rameters and operating status. The bottom pane is a terminal win-
dow. It gives the ability to work directly with a Command Line Inter-
face (CLI), without a GUI, by entering CLI commands. The bottom 
pane also contains a log window that shows the log records coming 
from selected unit. 
 
To work with the program, the operator needs only to connect PC’s 
COM port to local unit’s maintenance port. AWare automatically gen-
erates the network tree displaying the locally connected unit in the 
root of the tree. AWare uses CLI commands for interaction with the 
radio modem. 
 
The “Dealer” version of AWare provides the tools to preprogram the 
maximum output power level, channel spacing, and channel planning 
for specific countries and users. The “End-User” version allows an 
operator to select the settings preprogrammed by the dealer. The 
“Workshop” version of AWare provides the calibration tools used by 
repair centers to recalibrate the units.  
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3.1  PRODUCT FEATURES 

3.1.1 MANAGEMENT 

AWare is intended to manage the ArWest radio modems, it provides 
dialog boxes to change and configure all radio options. The following 
unit’s settings are configurable through AWare: 

1.  Data port parameters (Line parameters); 
2.  Wireless transfer parameters; 
3. Radio parameters (TX/RX etc.) 
In addition to the individual option-tuning feature, AWare provides 
compound options for downloading feature. The downloading proc-
ess uses X-Modem protocol that both the unit and the PC program 
are supporting. The manufacturing will provide configuration in ship-
ping packages so every user can configure each unit with default pa-
rameters provided by vendor.  

3.1.2. ALARMS 

There is a callback feature for reading the radio alarms. It is possible 
to activate and deactivate this feature in any device after each de-
vice sends its alarm status to the PC where AWare is running. The 
well-designed graphical user interface on AWare shows each particu-
lar alarm on the corresponding unit and with an operator’s request 
shows detailed description of that alarm. 

3.1.3  STATISTICS 

With a right-click of the mouse on a specific option on the menu bar, 
it is possible to view the statistics information on each unit.  In the 
Statistic window an operator can see link status: number of error 
packets or bits arrived during unity of time (Bit Error Rate - BER), 
number of packets sent/received etc.). Such information can be 
shown in textual or graphical form. It is also possible to change the 
unit of time (scaling). 
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3.2  PRODUCT OVERVIEW 

3.2.1  USER INTERFACE CONVENTIONS 

AWare uses the following user interface conventions: 

• Menu options and buttons that end with three dots (...) dis-
play a dialog window when selected. . 

• Menu options that are followed by a shaded arrow display a 
submenu when selected. 

• Buttons not followed by three dots or shaded arrow performs 
a function (command) when selected. 

• Underlined letters in menu options identify keyboard short-
cuts. 

• If you are using a PC keyboard, hold down the [Alt] key and 
press the key underlined in the menu option to select that op-
tion. 

• The arrow keys on the keyboard allow an operator to scroll 
up, down, right, or left within a menu. 

• Menu options are dimmed when they are not active for a par-
ticular window. 

• All windows and dialog boxes in AWare indicate object or 
property name in the title bar for which they are activated. 

3.2.2  MAINFRAME 

The AWare Mainframe has three child windows: Site View (left 
pane), Main (right pane), and Display (bottom of the Mainframe). 
The double-clicking magnifies the child windows. The magnified child 
window can be docked back to the original position by the double-
clicking on its title bar. 
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Figure 3-1: Mainframe Default View 

 

 
Figure 3-2: Mainframe with Undocked Child Windows 

3.2.3  SITE VIEW PANE 

This window shows the list of all units in the wireless network. The 
wireless cluster is pictured as a tree with the Base/Primary unit as 
the root. 

Operators are able to refresh the content of window through the 
main menu or popup menu by clicking mouse’s right button. The re-
fresh command can be activated manually or by setting polling op-
tion in the Preference dialog box. The system reacts on this com-
mand inactively because of slow wireless connection of the service 
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channel. 

In the “Dealer” version of AWare, the Site View Pane is also used to 
display the tree of available unit profiles. The “Unit Profile” tree pro-
vides an operator with the tools to select, add, or delete a unit pro-
file, or a folder of units’ profiles. 

The default position for Site View Pane is in the left side of main win-
dow. 

3.2.4  MAIN PANE 

AWare Main pane contains the Quick View tab that displays the se-
lected unit’s main configuration parameters and operating status. 
The Main tab is used also for the Statistics tabs, which can be acti-
vated through the Performance menu items (see section 3.2.11) 

Any of Statistics tabs can be opened and hidden by the operator. 
Meanwhile the Quick View tab is always in the Main pane and can be 
hidden only if the pane itself is hidden. 

3.2.5  DISPLAY PANE 

This window shows the log records coming from selected unit. The 
log records include all “Informative Events” with the time stamps 
along with the “System Errors/Major Alarms” and “Warnings/Minor 
Alarms”. The log information can be accumulated, even if the unit is 
not selected (in the background). This window gives the operator the 
ability to sort and filter log information by user-preferred criteria (by 
date, by type and so on). In this window, it is also possible to accu-
mulate all logs coming from AWare itself. 

The Terminal tab of the Display pane is designed for advanced op-
erators to give them an ability to work with unit directly without GUI 
using the CLI commands. 

3.2.6  MENU BAR 

The menu is a major entry point for all program features. The opera-
tor through this interface can access and change the properties of 
the AlphaWave radio. The Menu Bar consists of following items: 
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Figure 3-3: Menu Bar 

3.2.7  FILE MENU 

The configuration information is stored in the Configuration Profiles. 
The Configuration Profiles can be saved or loaded under the File op-
tion of the menu bar. If necessary, this option allows the operator to 
set the same configuration of one unit on a different unit simply by 
loading it. The operator may save as many Configuration Profiles as 
he needs.   

The File Menu contains the following commands (Figure 3-4): 

 

Figure 3-4: File Menu 

Where: 

New Profile – to create a New Profile; 
Open – to open a Profile from the hard or floppy disk; 
Save – to save the modified Profile to the same device from 

where it was loaded; 
Save As – to save a newly created or modified Profile on the 

specified devices with the specified name and “*.awn” exten-
sion; 

Exit – to exit AWare. 

3.2.8  EDIT MENU 

This menu item (Figure 3-5) helps to configure the radio’s external 
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and internal parameters. Those parameters are, input/output line 
properties, link configuration, radio modems configuration and so on 
(see section 5). 

The AWare Preferences item in the Edit Menu helps to setup the 
user’s Preferences for AWare. 

 
Figure 3-5: Edit Menu 

Where: 

New Unit – to add a new unit into the wireless network/link; 
Delete Unit – to delete the selected unit from the wireless net-

work/link; 
Unit Properties – to open a configuration dialog box for the se-

lected unit; 
AWare Preferences – to open AWare preferences dialog box; 
Load Configuration – to load a configuration to/from the selected 

unit from/to the open Configuration Profile. 

3.2.9  VIEW MENU 

The View menu intended to show/hide all toolbars, menus and win-
dows to construct working layout. 
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Figure 3-6: View Menu 

Where: 

Menu Bar – Show/Hide menu bar; 
Tool Bar – for hide/show the tool bar; 
Status Bar – for hide/show the status bar; 
Site View Pane – for hide/show the site view pane; 
Display Pane – for hide/show the terminal and log tabs in the dis-

play pane; 
Main Pane – for hide/show the main pane 

3.2.10  TOOLS MENU 

The Tools menu consists of following items: 

 
Figure 3-7: Tools Menu 

Where: 

Unit Reboot – used to access “Reboot” dialog box; 
Test Kit – provides a set of installation support and diagnostic 

utilities (see section 6.1); 
Download Image – used to access the Firmware Image 

Downloading Manager; 
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Dealer Configuration – provides a set of tools to edit and load 
Dealer Configuration Parameters (available for Dealer and 
Workshop Version); 

Factory Configuration – provides a set of tools to calibrate the 
unit and download Calibration Parameters to the unit 
(available only for Workshop Version); 

The “Dealers Configuration” sub-menu of “Tools” menu is intended 
to manipulate the dealer’s configuration File. “Dealer Configuration” 
sub-menu contains the following items (Figure 3-8): 

 

 
Figure 3-8: Dealer Configuration Sub-menu 

 

• Edit Dealer Configuration – opens dealer configuration dialog 
box to edit dealer configuration parameters 

• Export Dealer Configuration – save dealer configuration into 
the file on the disk. The New Profile dialog box uses this file to 
choose the dealer configuration as basis for network profile. 

• Import Dealer Configuration – load Dealer Configuration file 
into the system for editing it. The “Import Dealer Configuration” 
menu item also substitute dealer configuration file in the profile 
that currently active in AWare. 

• Download Dealer Configuration – download Dealer Configura-
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tion parameters into the unit through the serial interface. 
 
The “Factory Configuration” sub-menu of “Tools” menu provides an 
access to the tools intended for the unit calibration. “Factory Con-
figuration” sub-menu contains the following items (Figure 3-9): 
 

 
Figure 3-9: Factory Configuration Sub-menu 

• Export Factory Configuration – save dealer configuration into 
the file on the disk. The New Profile dialog box uses this file to 
choose the dealer configuration as basis for network profile. 

• Import Factory Configuration – load Factory Configuration file 
into the system for editing it. The “Import Dealer Configuration” 
menu item also substitute dealer configuration file in the profile 
that currently active in AWare. 

• Download Factory Configuration – download Factory Configu-
ration parameters into the unit through the serial interface. 

• Calibration Kit – provides access to the unit calibration tools 
(see section 6.3). 

3.2.11  PERFORMANCE MENU 

The Performance Menu is intended to retrieve the statistics from the 
unit and present the retrieved information in graphical formats: 
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Figure 3-10: Performance Menu 

Where: 

Rx/Tx Statistics – opens the tables and graphs of performance 
information unique for ArWest radio modems not covered by 
G.821 standard of ITU. 

G.821 Statistics – opens the graphs of the Error Performance Pa-
rameters and Objectives defined by G.821 standard of ITU. 

RSL - opens the graphs of received signal level for ArWest radio 

3.2.12  WINDOW MENU 

The “Window” menu (Figure 3-11) contains the following commands: 
 

 
Figure 3-11: Window Menu 

Where: 

Default Desktop – to open and arrange the windows as it was de-
signed for Default Desktop; 

Cascade – to arrange windows so they are all partially visible; 
Tile – to arrange windows horizontally or vertically so they are all 

very visible. 

3.2.13  HELP 

This menu item helps with the questions that arise about the avail-
able commands, information about commands usage and general 
information about AWare. 
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Help contains the following items: 
 

 
Figure 3-12: Help Menu 

Where: 

Help Topics – opens application help topics in the separate dialog 
with contents, index and find tabs; 

About AWare – opens about dialog box. 
 

3.2.14  TOOL BAR ICONS 

The AWare Tool Bar contains the buttons with images so the opera-
tor can quickly associate the command with the image (see Figure 3-
13). 

 
Figure 3-13: AWare Tool Bar 

Where: 

 -  Create a New Profile; 

 - Save Profile; 

 - Open Profile; 

 - Add a Unit into Profile; 

 - Delete the selected unit from the Profile; 

 - Activate the selected unit’s Configuration Properties; 

 - Download unit’s configuration from the Profile into the unit;  
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4. CONFIGURATION FILES 

The configuration information used by AWare is stored in four types 
of files: 

• AWare Preferences 
• Factory Configuration files  
• Dealer Configuration files  
• User Setting Profile  

Factory Configuration files can be modified only by “Workshop” ver-
sion of AWare. While Dealer Configuration file can be modified and 
loaded into the unit by “Dealer” version of AWare. 

4.1 AWARE PREFERENCES 

The “AWare Preferences” file is where AWare settings are stored. It 
includes two groups of setting parameters: 

• Startup Preferences 
• Communication Preferences 

To open the “AWare Preferences” dialog box, the operator must click 
“AWare Preferences” menu item on “Edit” menu. 

4.1.1 STARTUP PREFERENCES 

AWare allows three different startup procedures, which could be se-
lected from the Startup preferences of the preferences dialog box: 

• New Profile 
• Upload the Unit Profile 
• Open last Saved Profile 
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Figure 4-1: AWare Preferences 

4.1.2 COMMUNICATION PREFERENCES 

The Communication preferences tab allows a variety of options for 
PC’s COM port selection. For Dedicated Maintenance Port, the COM 
ports for both Maintenance and Data must be defined. For Non-
dedicated Maintenance Port, the shared COM port and the control 
line must be selected (DTR or RTS). 

 
 
Figure 4-2: Communication Preferences 

By default, the Dedicated Maintenance Port is unchecked and Set-
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tings for Maintenance serial port are grayed out. 

If the Dedicated Maintenance Port is checked then the MP/DP Selec-
tion Line option must be grayed out and controls for Maintenance 
serial port settings become active. 

4.2 CONFIGURATION FILES 

The configuration files’ structure has a binary format to protect con-
figuration file from any type of external intervention from the user. 
The file has a tree type structure to keep information of the whole 
cluster in the root of the tree and each unit’s configuration in the 
nodes. Further changes of any parameter will be saved in the con-
figuration file in its corresponding place. 

“Dealer” and “Workshop” versions of AWare are used to create, 
modify, save on disk, and load into the units the “Dealer Configura-
tion” and “Factory Configuration” files. The “Dealer Configuration” 
and “Factory Configuration” tools are developed for this purpose (see 
sections 6-2, and 6-3).  

4.3 USER SETTINGS PROFILE 

User Setting Profile defines the settings of the wireless cluster/link 
and the units in that cluster/link. At the same time, an operator is 
able to open only one profile in AWare and work with units in that 
cluster. The User Setting profile contains two groups of information: 

• Cluster/Link Properties – common for all units in the same 
wireless cluster 

• Unit Specific Properties – setting unique for each unit in the 
wireless cluster 

The group of Cluster/Link Properties includes: 

• Frequency 
• Link Data Rate 
• Topology 
• Scrambling Seed 

The group of unit specific properties includes: 

• Data Port Rate 
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• Output Power Level 
• Protocol 
• Sleep mode 
• Alarm Settings 

4.3.1 CREATE A USER SETTING PROFILE 

The menu item File > New Profile creates a new User Setting Pro-
file (see Figure 4-3). By default, it creates one Base Station unit in 
the profile with factory default User Settings for that unit and opens 
unit properties dialog box to modify user settings for newly created 
unit. 

The tree on the left shows all available configurations provided by 
dealer or automatically generated from existing units. By clicking on 
each configuration, the corresponding fields on the right will show all 
settings filled up by dealer for selected item. 

The beige title on the dialog box shows the Product Name for current 
configuration.  

• Maximum Power – determines maximum output power 
 settable by the operator through the Unit Settings tools. 
• Call Sign – indicates the unique ID assigned by FCC (filled by 

 dealer). 
• Channel Spacing – defines channel spacing 25 kHz, 12.5 

 kHz, or 6.25 kHz. 
• Channel Mapping – defines the list of central frequencies 

 mapped to channel numbers.
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Figure 4-3: New Profile Dialog Box 

The New Profile dialog box indicates the list of available units’ con-
figurations. The indicated unit configurations include Factory and 
Dealer configurations (refer to section 6.2 for Dealer Configuration). 
The full list of products currently supported by AWare includes: 

 

First two characters of name indicate the model family (AW). The fol-
lowing three digits after the dash is an operating frequency band: 

 

AW400 AlphaWave UHF transceiver 
AW200 AlphaWave Chinese version VHF transceiver 
AW100 AlphaWave VHF transceiver 

AW400R Receive-Only UHF radio 
AW200R Receive-Only Chinese version VHF radio 
AW100R Receive-Only VHF radio 
AW400Plus High Power UHF transceiver 
AW200Plus High Power Chinese version VHF transceiver 
AW100Plus High Power VHF transceiver 
Table 4-1:     Products supported by AWare 

400 403 to 470 MHz UHF band radio 
200 220 to 232 MHz Chinese version VHF radio 
100 150 to 170 MHz VHF radio 
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4.3.2 OPEN A USER SETTING PROFILE 

The full path of the User Setting Profile last used is stored in the sys-
tem registry. The program automatically opens that profile after 
starting up when corresponding option is selected in the AWare pref-
erences dialog box. 

Choosing the “Open” menu item in “File” menu opens the File Open 
dialog box. This is where the chosen profile is loaded. Then the pro-
gram automatically loads the newly chosen profile. 

4.3.3  SAVE A USER SETTING PROFILE 

To store the current user settings, the “Save” and “Save As” are be-
ing used. “Save As” menu item opens “Save File” dialog box, which 
allows an operator to store the current user settings into the differ-
ent file. 

4.3.4 ADD A UNIT INTO PROFILE 

By selecting this menu item, the program adds Remote/Secondary 
units into the Profile. A unique name and serial number of all zeros 
specified for newly added unit. From this point the operator is able 
to set the unit specific parameters or change the cluster parameters 
for all units. The newly added into profile unit has the factory default 
user settings. 

4.3.5 DELETE A UNIT FROM PROFILE 

The Delete Unit Menu item deletes the unit from the User Setting 
Profile. The delete operation can not be performed on the root item 
in the Site View configuration tree, as long as the configuration of 
the rest of all units is based on the root item’s unit. 

4.3.6  SELECT A LOCAL UNIT 

The “Local Unit” menu item specifies the unit that locally connected 
to the PC through the Serial Interface. This option used by AWare to 
substitute the Serial Number automatically (if last one is all zeros) 
with the serial number of locally connected unit during download 
process. The green icon will indicate local unit in the Profile Tree. 
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There should always be one unit in the profile and this one unit will 
be local. 
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5. PLANNING OF WIRELESS CLUSTER  

To open “Unit Properties” dialog box for the unit selected in the Site 
View pane, the operator can select the “Unit Properties” item from 
“Edit” menu (”Edit > Unit Properties… “.) Double-clicking on the unit 
icon in the Site View pane also opens the “Unit Properties” dialog. 

The left pane of the “Unit Properties” dialog is a unit’s User Setting 
Tree intended to facilitate and visualize the setup process. Each node 
in the tree pane corresponds to a specific tab on the dialog’s right 
side. The tab can be selected by clicking on the node in the tree. 

The AlphaWave radio modems have four main groups of settings: 
Identification, Link, Modem and Serial Port Properties. Some of the 
units’ parameters are common for all units in the wireless link/
cluster. A warning message appears if the operator attempts to set a 
parameter mismatched with the rest of the units in the wireless link/
cluster. The warning message should have an option control to auto-
matically set the common parameter for all units in the wireless link/
cluster or cancel the new setting. 

To configure the units, AWare uses CLI commands described in Ap-
pendix B 

5.1 IDENTIFICATION PROPERTIES 

On the Identification Properties tab (see Figure 5-1), there is unit’s 
identification information such as: 

• Product Name –With this option, the operator can select one 
of the ArWest radio models (see Section 4.3.1). 

• Call Sign – Indicates the unique ID assigned by the FCC (filled 
by dealer). 

• Current Software – Shows/Actives embedded software version 
that is running on the unit. 

• Unit Name – Indicates the logical name of the unit given by 
the operator. 

• Owner – Indicates the network ownership (filled by the opera-
tor). 
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The last three identification parameters (Unit Name, Owner and Call 
Sign) are user assigned settings. The Embedded Software version 
should be retrieved from the unit through its maintenance serial 
port. For AlphaWave operating in Half or Full Duplex modes it can be 
read also over the air. 

 

Figure 5-1: Identification Properties 

5.1.1 FACTORY PROPERTIES 

The Factory Properties is a sub-tab of the Identification Properties 
tab (see Figure 5-2). It contains the information that the vendor sets 
during manufacturing process.  
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Figure 5-2: Factory Properties 

The unit’s factory identification includes: 

• Mandatory Entry of Serial Number – Specifies whether 
AWare will automatically fill the Serial Number during 
downloading configuration into the unit or the operator should 
mandatory enter serial number in the “Serial Number” field. 

• Serial Number – Indicates the serial number (six/6 bytes) of 
the unit given by the manufacture; 

• Factory Software Version – The version of software image 
loaded in factory. The factory software becomes active if op-
erator updated image is corrupted or failed. The factory soft-
ware cannot be upgraded on the field. 

• User Software Version - The version of software image 
loaded or upgraded by operator. 

5.2 LINK PROPERTIES 

The Link settings are split between three tabs: Link General Proper-
ties, Link Protocol Properties, and Link Frequency Properties. 

Changing Link Properties of unit’s configuration may cause link inter-
ruption. That is why after choosing Base/Primary unit’s configuration 
the operator has limited choices for secondary unit. 
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5.2.1 LINK GENERAL PROPERTIES 

 

Figure 5-3: Link General Properties Tab 

The following controls reside in the Link General Properties tag: 

• Modulation: 

 
This control should show the modulation type along with the 
wireless link data rate that is provided by a specific radio mo-
dem. This option is available only for Base/Primary unit. 
• RF Output Power Level (selectable from 13dBm/20mW to 

Maximum Value defined by Dealer in the “Dealer Configura-
tion”). 

• RF Frequency Channel: 

  CS = 6.25 
kHz 

CS = 12.5 
kHz 

CS = 25 
kHz 

DBPSK 2.4 kbps 4.8 kbps 9.6 kbps 

DQPSK 
(default) 

4.8 kbps 9.6 kbps 19.2 kbps 

D8PSK 7.2 kbps 14.4 kbps 28.8 kbps 

D16QAM 9.6 kbps 19.2 kbps 38.4 kbps 
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• Automatic Scanning – it is a default option that grays out the 
Frequency Channel edit box. The List of frequencies scanned 
by the unit can be assigned through the Link Frequency Prop-
erties tab. 

• Manual Selection – with this option, the operator can select 
one of the fixed channels (the actual range is based on the 
facture configuration). The Frequency Channel can be se-
lected using the Frequency Channel combo box 

• Frequency Hopping – the selected Frequency Hopping grays 
out the Frequency Channel edit box. The List of hopping fre-
quencies can be assigned through the Link Frequency Proper-
ties tab. 

• Hopping Pattern: 
 This control is applicable only if the Frequency Hopping mode 
 is selected. The network operator selects one of the 32 avail
 able Hopping Patterns. 

 

5.2.2 LINK PROTOCOL PROPERTIES 

The following controls reside in the Link Protocol Properties tab: 

The Protocol sub-group contains radio-button to choose between two 
types of units: Base and Remote each type has specific list of proto-
cols that listed in the List of Protocols combo-box.  

• Base 
− Simplex Transmitter 
− Primary Transceiver 
− Full Duplex 

• Remote 
− Simplex Receiver 
− Secondary Transceiver 
− Full Duplex 

• Delay (this variable is valid only for “Transmitter” mode): 

Note: 
• RF Frequency Channel option is available only for Base/

Primary unit. It is same for all units in the network. 
• For Receive-Only radio, this option is disabled. 
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− Range (0-7) 
− Scrambling: On/Off  

• Link ID (this variable is valid only if Scrambling is “On”): 
− Seed for Pseudo-Random Sequence Generator (1-255) 
− ARQ: 
 The ARQ check box enables/disables the Automatic Repeat 
 Request option. This option is not available for “Repeater” 
 and Simplex modes (default is unchecked). 

• Number of Requests (this variable is valid only if ARQ is ”On”) 
− Range ( 1 – 8 ) 

• FEC: 
− The FEC check box enables/disables the Reed-Solomon FEC 

coding (default is checked). 

 

Figure 5-4: Link Protocol Properties Tab 

 

5.2.3 LINK FREQUENCY PROPERTIES 

This tab displays the list of up to 32 available frequencies mapped to 

Note: 
• The link with Receive-Only radios does not support ARQ op-

tion. 
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corresponding channels. AWare displays the list of available carrier 
frequencies based on information from the specific unit profile file. 

 

Figure 5-5: Link Frequency Properties Tab 

Two buttons under Update Form group helps to update the list of 
frequencies from saved dealer configuration or directly upload from 
the unit. 

5.3 MODEM FEATURES PROPERTIES 

This menu item helps to configure radios’ service features such as 
the alarm indication mode and alarm control lines’ behavior, and the 
sleep mode. 

5.3.1 MODEM SLEEP PROPERTIES 

The Sleep check box enables the sleep mode. The unit with the en-
abled sleep mode goes to sleep if there is no activity on the wireless 
link during waiting time defined by Wait edit box (range 10 – 2550 
ms). 

The sleeping AlphaWave unit can be activated again by the real-time 
CLK, DTR/RTS lines, and command received through TTL inputs. The 
operator can select one, two, or all three conditions: 
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• Activate by Real-time clock: 
• After 100 to 2550 ms of sleeping time 
• Activate by Control Lines: 
• DTR 
• RTS (default) 
• DTR & RTS 
• Activate by Sense input lines: 
• Sensor 1 
• Sensor 2 
• Sensor 1 and Sensor 2 

To activate the sleeping unit, the operator can select either Sense 
TTL inputs or/and RTS and DTR inputs. 

 
Figure 5-6: Sleep Properties Tab 

5.3.2 MODEM ALARM PROPERTIES 

The AlphaWave radio modem has the ability to indicate alarms using 
Alarm LED indicator and two TTL outputs. 
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The First Event Output (TTL1) control allows the operator to route 
the alarms and the inputs from remote sensors to the first event 
(TTL) output: 

• Sensor 1 (the sensor’s input on remote unit, default value) 
• Sensor 1 and Sensor 2 (logic “and” of the sensors’ inputs on 

remote unit) 
• Sensor 1 or Sensor 2 (logic “or” of the sensors’ inputs on re-

mote unit) 

The Second Event Output (TTL2) control allows the operator to rout 
the alarms and the inputs from remote sensors to the second event 
(TTL) output: 

• Sensor 2 (the sensor’s input on remote unit, default value) 
• SYNC Loss 
• BER > Threshold or SYNC Loss 

The BER control allows the operator to select the BER threshold level 
for second event output in case of selected “BER > Threshold or 
SYNC Loss”: 

• BER >10 –3    (default value) 
• BER >10 –2 

 

 

Note: The Alarm Properties are not available for Simplex Trans-
mitter configuration. 
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Figure 5-7: Alarm Properties Tab 

5.4 SERIAL PORT FEATURES PROPERTIES 

This menu item helps to configure radios’ service features such as 
the user data port and maintenance port settings. 

5.4.1 DATA PORT PROPERTIES 

From the Port tab of Unit Configuration dialog box the operator can 
configure the following data port parameters: 

• Baud Rate – indicates the operating rate for the data port 
(300 bps to 115 kbps). The “MP Baud Rate” operating option 
does not define the data rate specifically. In this mode on, the 
same data rate is used for both maintenance commands and 
user data. The baud rate is defined by Maintenance Port set-
tings or automatically detected when the serial port operates 
as a Maintenance Port. 

• Parity Scheme – for enable/disable parity checking, can be 
one of the following settings: none, odd, even. 

• Byte Size – number of bits in the bytes transmitted and re-
ceived 

• Flow Control – This field indicates the Data Port flow control 
option: 
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Hardware - (RTS/CTS) flow control; 
Xon/Xoff – flow control is performed by software; 
None – flow control is not used. 

 
Figure 5-8: Data Port Properties Tab 

5.4.2 MAINTENANCE PORT PROPERTIES 

From the Port tab of Unit Configuration dialog box the operator can 
configure the maintenance port parameters: 
 

• Baud Rate – indicates the operating rate for the maintenance 
port (300 bps to 115 kbps). The “Auto” operating option does 
not define the data rate specifically. In this mode on, the baud 
rate is automatically detected using the maintenance com-
mands as the key words. 

• Byte Size – number of bits in the bytes transmitted and re-
ceived. 
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6. TOOLS 

AWare built-in installation and system monitoring tools are using 
special CLI commands, which are typically not used by the operator 
working with the unit through the Hyper Terminal. This list includes 
the following commands: 

6.1 TEST KIT 

The Test Kit is a set of four utilities that facilitate unit installation 
and maintenance. AWare tools allow the operator to investigate the 
frequency spectrum, to align the antennas precisely, to set a reason-
able output power level, and eventually check the link using the BER 
test. 

6.1.1 SPECTRUM ANALYZER 

The Spectrum Analyzer test run on an AlphaWave unit is activated 
by the SPECTRUM command sent from AWare. By this command the 
unit scans the full frequency spectrum defined by the Factory De-
fined Configuration file and stores the measured values of the re-
ceive signal levels (RSL) in the RAM memory. To upload the meas-
ured RSL values from the unit the X-Modem protocol is used.  

The Spectrum Analyzer test provides a graphical representation of 
the measured RSL values using two-dimensional graphs with the fre-
quencies scaled on the abscissa (y axis) and RSL scaled in dBm on 
the ordinate (x axis). The Start and Stop Frequency controls define 
the Frequency Span, which determines the scale on the abscissa. 
Meanwhile the range of the RSL on the ordinate is fixed and equal to 
10 dB, in range of –120 dBm to –20 dBm (Reference Level). 

The following controls are available: 

• Start Frequency – defines the sweep starting frequency in 
MHz; 

• Stop Frequency – defines the sweep stopping frequency in 
MHz; 
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• Refresh – starts the Spectrum Analyzer test procedure on the 
unit. 

 

Figure 6-1: Spectrum Analyzer Dialog Box 

To activate Spectrum Analyzer dialog box: 

1. Select a unit name (icon) from the Site View pane. 
2. Select the Tools > Test Kit > Spectrum Analyzer item of 

AWare main menu bar. 

6.1.2.  BERT 

The BERT test is developed to test the wireless link quality in the 
network. It provides the BER statistics measured by a built-in test 
sequence generator.  

The transmit output power level of the AlphaWave units is user se-
lectable. The power level must provide the intact data transmission 
with minimal influence on other radio systems. The BERT test is also 
intended to estimate the quality of received radio signal depending 
on Transmit Power.  

There are two states for this test: Transmit or Receive. By selecting 
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the Transmit option, the network operator will be able to select 
these values for BERT test: 

• The Output Power Level for transmitter: defined through the 
 dedicated control in the range from 13 to 33 dBm (to set the 
 required values, the LINK PWRB command must be used) 

• Interval – defines in ms the interval in which the frames will 
be transmitted. The Interval range is 125 to 1000 ms. 

• The modulation type of transmitter – DBPSK, DQPSK, D8PSK, 
D16QAM 

In Transmit state, AWare first sets the outputted power level and 
then periodically sends the test sequences in predefined intervals. By 
receiving that sequence, the unit starts transmitting the received 
frames to the receiver. 

 

Figure 6-2: BERT Transmit Dialog Box 

In Receive state, AWare BERT dialog box shows the received and 
lost frames counters, total received bits, user data, rate of BER and 
FLR (Frame Loss Rate). The BERT dialog also indicates the power 
level of transmitter (TSTUFR REMOTEPWR command will be used), 
the RSSI/RSL on receiver (it will be obtained through Statistics In-
terface), and Recommended Output Power Level for transmitter 
which is calculated based on the transmitter’s power level, receiver’s 
RSSI/RSL level, BER and frame loss rate tolerance on receive site. 
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The allowed values for BER tolerance is <10-3, <10-4, and <10-5. The 
range of tolerance for frame loss rate is in the range from 10%, 1%, 
and 0.1%.  

 

Figure 6-3: BERT Receive Dialog Box 

To calculate the Recommended Output Power Level, the following 
formula must be used: 

1. RPWR = Fade + PWR – RSL + RXS (recommended value 
range is from 13 to 33dBm) 

2. Fade is the Fade Margin in dB as a function of the error toler-
ance: 

 

  BER FLR 
45 dB <10-5 0.1% 
40 dB <10-4 1% 
35 dB <10-2 10% 
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 RXS is the receiver sensitivity as a function of the selected 
 modulation type and channel spacing:  

 

 PWR is the transmitter’s output power level and RSL is the 
 measured receive signal strength. 

To activate BERT Test dialog box: 

1. Select a unit name (icon) from the Site View pane. 
2. Select the Tools > Test Kit > BERT Test >Transmit or Re-

ceive option of AWare main menu bar. 
 

 

  CS Modulation 

-113 dBm 25 kHz DBPSK 

-116 dBm 12.5 kHz DBPSK 

-119 dBm 6.25 kHz DBPSK 

-110 dBm 25 kHz DQPSK 

-113 dBm 12.5 kHz DQPSK 

-116 dBm 6.25 kHz DQPSK 

-97 dBm 25 kHz D8PSK 

-110 dBm 12.5 kHz D8PSK 

-113 dBm 6.25 kHz D8PSK 

-94 dBm 25 kHz D16QAM 

-97 dBm 12.5 kHz D16QAM 

-110 dBm 6.25 kHz D16QAM 

Note: The Transmit mode of BER test is not applicable for the 
receive-only systems. 

 The BERT test cannot be run for Simplex Transmitter since 
the remote Simplex Receiver operating in receive-only 
mode does not provide information needed for link quality 
estimation. 

 The BER does not include the bits in the lost frames. 
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6.2 DEALER CONFIGURATION TOOLS 

Dealer Configuration Tools is the group of software utilities intended 
to load Dealer Configuration Parameters. Dealer Configuration pa-
rameters can be stored in the file on the disk and used from the New 
Profile dialog box. 

To activate “Dealer Configuration” dialog box the dealer has to select 
Tools > Dealer Configuration > Edit Dealer Configuration Menu item.  
“Dealer Configuration” dialog box consists of two sections in the tab 
tree: 

 

Figure 6-4: Identification for Dealer Configuration 

The Identification tab intended to configure main features of the 
Dealer Configuration. The Identification tab contains following fields: 

• Channel Spacing – specifies the channel spacing for current 
configuration. The channel spacing can be one of three different 
values (6.25 kHz, 12.5 kHz, and 25 kHz) all these values may be 
specified by the dealer for different users 

• Call Sign – Indicates the unique ID assigned by FCC 
• Maximum Output Power Level – specifies maximum allowable 

output  
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6.2.1 CONFIGURING CHANNEL MAPPING 

 
Figure 6-5: Channel Map for Dealer Configuration 

 
The Dealer uses Channel Map tab to program frequencies and map 
them to corresponding channels. The maximum number of available 
channel for all ArWest radios is 32. The Channels List field shows all 
programmed frequencies in the current dealer configuration. The 
central frequencies are in MHz format and they have to be divisible 
to minimum channel spacing – 6.25 kHz. The dealer can add and 
remove channels from dealer configuration, also he can change cen-
tral frequency and channel mapping. 

6.3 FACTORY CONFIGURATION TOOLS 

The Factory Configuration tools is a set of software utilities intended 
to create, export/import to/from external storage, and download to 
unit factory configuration parameters (including calibration parame-
ters). The calibration parameters include TCXO tuning value (from 1 
to 32), and ALC and RSSI/RSL calibration tables. 
 

 

Note:  The Calibration option is available only in the “Workshop” 
version of AWare. 
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6.3.1 TCXO CALIBRATION TOOL 

This option allows operator/technician to adjust the output frequency 
value if it varies during the operation from the predefined value. By 
opening the TCXO Calibration Tool dialog box the operator/
technician first orders the AlphaWave unit to generate continuous bit 
stream of all 0-s. The following frequencies are used to measure the 
TCXO accuracy: 
 

 
 
The Up/Down controls allow operator/technician to tune the TCXO 
generated frequency. If the difference between the nominal and 
measured value is less than Required Accuracy then the test can be 
completed. To save the TCXO Control value in the Configuration Im-
age, the operator/technician must click the “Apply” button. 
 
AWare automatically switches off the testing mode of unit, if the 
TCXO Calibration dialog box is closed. 
 

 
Figure 6-6: TCXO Calibration Box 

 
To activate the TCXO Calibration Tool dialog box: 
1. Select a unit name (icon) from the Site View pane. 

  AW400 AW200 AW100 
Testing Frequency 470 MHz 230 MHz 170 MHz 

Required Accuracy 400 Hz 200 Hz 150 Hz 
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2 Select the Tools > Factory Configuration > Calibration Kit > 
TCXO of AWare main menu bar. 

6.3.2 ALC CALIBRATION TOOL 

This option allows operator/technician to build the ALC Table used by 
unit’s Automatic Level Control (ALC) module to set the precise value 
of required output power level. The ALC Table lists the measure-
ments provided by unit’s built-in Power Detector for the output 
power levels from 13 dBm to 33 dBm. The ALC Table also contains 
the DAC gain and attenuation level for each output power level in 
the list. 
 

 
Figure 6-7: ALC Calibration Box 

 
By opening the ALC Calibration Tool dialog box the operator/
technician first orders the AlphaWave unit to generate 511-bit length 
pseudo-random sequence. 
 
The measurement procedure shall be as follows: 
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1. Set the Desired Output power level to 13 dBm (Power); 

 
2. Change the Attenuation value from 31 to 0 (by step 1); the DAC 

gain is automatically set to 5000 central value (to set Attenua-
tion, DAC, and HPA biasing, the ALC command must be used, see 
IS-00003-104); 

3. Measure the output power level and go to step 4 if the difference 
between nominal desired and measured values is less than Re-
quired Rough Accuracy (± 2 dBm), if not repeat step 2; 

4. Change the DAC Gain value from 2000 – 9000; 
5. Measure the output power level, if the difference between the 

nominal desired and measured values is less than Required Accu-
racy (± 0.3 dBm) then store the Measured Detector value in the 
ALC Table using “Apply” button and go to step 6, if not repeat 
step 4. 

6. Increase the output power level by 1 dB and go back to step 2. 
 
The test is completed if the ALC Table is filled for all output power 
levels from 13 to 33 dBm. The Measured Power Detector values are 
stored in the unit’s configuration files image to be loaded into the 
unit (see section 6.4.2). 
 
To activate the ALC Calibration Tool dialog box: 
 
1. Select a unit name (icon) from the Site View pane. 
2. Select the Tools > Factory Configuration > Calibration Kit > 

ALC of AWare main menu bar. 

6.3.3 RSL CALIBRATION TOOL 

The RSL Calibration Tool is intended to map the receive signal level 
(RSL) to the receive signal strength (RSSI) measured by real time 
software and to show the AGC value in dB. The range of RSL is -120 
to -60 dBm. The Signal Generator used in calibration must cover the 
frequency range covered by the receiver being tested (100 to 470 
MHz to cover the frequency range from VHF to UHF). 
 
By opening RSL Calibration Tool dialog, the operator/technician first 

Note:  The HPA biasing level is explicitly defined by Desired 
Output Power level. 
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orders the AlphaWave unit to switch on the testing receive mode 
(TSTRX ON command). 
 

 
Figure 6-8: RSL Calibration Box 

 
The measurement procedure shall be as follows: 
 
1. Set unit’s receiver for 440.000 MHz central frequency 
2. Set signal generator to generate 440.00 MHz frequency with -

120 dBm output power level 
3. Set Receive Test mode using TSTRX ON command (see also IS-

00003-14) 
4. Save the RSSI value in the RSL/RSSI table using “Apply” button 

(the TSTRX command is used to read the RSSI value from the 
unit) 

5. Increase the input signal by 6 dBm (for output generator) 
6. Repeat steps 4 to 5 for up to -60 dBm 
 
Closing this dialog box stops the testing mode of unit. To load the 
RSSI/RSL Table into the unit, the Download FCFG dialog box must 
be used (see section 6.4.2). 
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To activate the RSL Calibration Tool dialog box: 
 
1. Select a unit name (icon) from the Site View pane. 
2. Select the Tools > Factory Configuration > Calibration Kit > 

RSL of AWare main menu bar. 

6.4 DOWNLOADING TOOLS 

6.4.1 DOWNLOADING A NEW IMAGE 

The Downloading procedure includes three steps to install upgraded 
versions of the embedded software images from the PC, on which 
AWare runs. AWare setup program provides the means to upgrade 
the embedded software images. 
 

• Select the Tools > Download Image command from main 
menu bar. The Download dialog box for the selected unit is 
activated (see Figure). 

• Select the downloadable image file in the computer by clicking 
Browse button – the File Info box shows complete informa-
tion about image file if selected file is the right image. 

• Select the downloadable image file in the computer by clicking 
Browse button – the File Info box shows complete informa-
tion about image file if selected file is the right image. 

• After selecting the image file, click the Download button to 
start downloading. The downloading progress is indicated in a 
separate dialog box. 
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Figure 6-9: Download Dialog Box 

 

 

6.4.2  DOWNLOADING A DEALER CONFIGURATION FILE 

To activate Downloading Dealer Configuration dialog box: 
 
1 Select a unit name (icon) from the Site View pane. 
2 Select the Tools > Dealer Configuration > Download Dealer 

Configuration …. 
 
To create the dealer configuration file, the “Dealer Configuration” 
dialog box is used (see section 6.2). 
 
For the end users the dealer configuration file is a read-only struc-
ture. It is prepared and loaded into the unit in production through 
the serial port using X-Modem protocol. 
 

 

Note: Downloading over the air is not possible for a receive-only 
system. 

Note:  Downloading of the dealer configuration file is available 
only in the “Dealer” version of AWare. 
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6.4.3  DOWNLOADING A FACTORY CONFIGURATION FILE 

To activate Downloading Factory Configuration dialog box: 
 
1 Select a unit name (icon) from the Site View pane. 
2 Select the Tools > Factory Configuration > Download Fac-

tory Configuration …. 
 
To create the dealer configuration file, the “Dealer Configuration” 
dialog box is used (see section 6.2)  
 
For the end users the factory configuration file is a read-only struc-
ture. It is prepared and loaded into the unit in production through 
the serial port using X-Modem protocol. 
 

 
 

Note:  Downloading of the Factory configuration file is available 
only in the “Workshop” version of AWare. 
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7. STATUS AND STATISTICS 

7.1  STATUS 

7.1.1  TERMINAL TAB 

This window is designed for the advanced operator, who is familiar 
with the system and CLI commands. It allows the operator to work 
with unit directly without GUI. The Terminal shows all information 
coming from the unit or transmitting towards it. It can be activated 
by selecting the appropriate item from menu bar or by right clicking 
on the unit in the Site View pane. 

 
Figure 7-1: Terminal Tab 

 
The Terminal window is located in the Display Pane as its tab. 

7.2  PERFORMANCE 

7.2.1 VIEWING G.821 STATISTICS 

AWare displays the Error Performance reports defined by the G.821 
Standard. Each statistical measurement graph displays up to 96 data 
points along the horizontal axis, and up to 900 seconds on the verti-
cal axis. Each data point along the horizontal axis represents 15 
minutes of performance data collection. The G.821 Statistics tabs 
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include ES, SES, ESR, SESR, Unavailable Time, and Available Time 
(see Figure 7-3): 
 
• Errored Second (ES) - is a one-second period in which one or 

more bits are in error. 
• Severely Errored Second (SES) - is a one-second period which 

has a bit error ratio more than 0.001 
• Errored Second Ratio (ESR) - shows the ratio of ES to total 

seconds in available time during a fixed measurement interval. 
• Severely Errored Second Ratio (SESR) - shows the ratio of 

SES to total seconds in available time during a fixed measure-
ment interval. 

• Unavailable Time - begins when the Bit Error Rate (BER) in 
each second is worse than 0.001 for a period of ten consecutive 
second (shows period of ten consecutive seconds when the BER 
in each second is worse than 0.001.) 

• Available Time - begins when the first second of a period of ten 
consecutive seconds each of which has a BER better than 0.001. 

 

 
Figure 7-2: G.821 Statistics 

 
The G.821 Statistics tab contains the following controls: 
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• Reset – Resets the statistic information; 
• Run – gets the statistic information; 
• Close - Close statistic window; 
• Help - Help options for statistic window. 

7.2.2 VIEWING RX/TX STATISTICS  

The Rx/Tx Statistics dialog window provides the AlphaWave specific 
statistic information not covered by G.821 standard. This dialog con-
tains nine tabs where the first tab exposes the numerical values for 
the monitoring parameters: 
 

 
Figure 7-3: RX/TX Statistics 

 
• Observed Error Counter (OEC) – shows the number of errone-

ous bits that have been detected by FEC decoder since the begin-
ning of the calculation. 

• Uncorrected Error Counter (UEC) – shows the number of er-
roneous bits that have not been corrected by FEC decoder since 
the beginning of the calculation. 

• Received Bit Counter (RBC) – indicates the actual number of 
bits received since the beginning of the calculation. 

• Bit Error Rate (BER) – shows the ratio of the number of cor-
rected errors to the number of bits received since the beginning 
of the calculation. 
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• Transmitted Frame Counter (TFC) – displays the number of 
transmitted frames since the beginning of the calculation. 

• Unrecoverable Frame Counter (UFC) – displays the number 
of received frames that have not been recovered by FEC decoder 
since the beginning of the calculation. 

• Lost Frame Counter (LFC) – displays the number of lost 
frames since the beginning of the calculation. 

• Received Frame (RFC) – displays the number of received 
frames since the beginning of the calculation. 

• Frame Loss Rate (FLR) – shows the ratio of the lost frame 
number to the total number of frames, which should be received 
since the beginning of the calculation. 

 
The tabs (OEC, UEC, RBC, TFC, UFC, LFC, RFC, and FLR) are the 
graphical representation of the monitoring parameters presented in 
time domain. 

7.2.3 VIEWING RSL STATISTICS 

The Receive Signal Level (RSL) Statistics dialog shows the current 
level of received signal in dBm. The statistical measurement graph 
displays up to 96 data points along the horizontal axis. The vertical 
axis shows the signal level in dBm. This tab contains a control to 
specify the measurement interval in seconds (the minimum interval 
equals to 5 seconds). During the measurement process AWare alters 
the diagram whenever the received signal’s diapason changes.

 
Figure 7-4: RSL Statistics 
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8. FIRMWARE COMPONENTS 
 

8.1 EMBEDDED SOFTWARE / FIRMWARE 

The Embedded Software/Firmware runs on the AlphaWave unit. The 
firmware consists of the following components: 
 

• Link Control Level (LCL) module, which includes MAC control-
ler and Framer; 

• Kernel is a multitask operating system specifically developed 
for AlphaWave, 

• Signal Processing module, responsible for modulation/
demodulation and FEC coding/decoding; 

• Configuration and Timing Control module; 
• Serial Line Control module. 

8.2 COMMAND LINE INTERFACE 

The built-in user-friendly Command Line Interface (CLI) allows a 
user to perform a full configuration of the unit and read the statistics 
and alarm status. It is the most powerful tool to configure the unit. 
It makes changes to all possible settings that system will not be able 
to determine automatically.  
 
The CLI commands allow user to configure and reconfigure the unit’s 
settings. The user configuration parameters that could be changed 
through the CLI are: 
 

• Data Port Settings 
− Baud Rate 
− Data Bits (8, 7) 
− Parity (Odd, Even, None) 
− Flow control (None, RTS/CTS, XON/XOFF) 

• Alarm Settings 
− See Section 1. 2.3 for details. 

• Radio Operation Modes 
− See Section 1.1.3 for details 

• Sleep modes 
− On/Off 
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− Activate by internal real-time clock 
− Activate through RTS/CTS lines 
− Activate by external sense lines 
− Activate by any combination of the parameters men-

tioned before 

 
The CLI commands also provide filing operations, which include: 

 
• Downloading 

− Unit’s Configuration files 
− Software Images 

• Uploading Unit’s Configuration files 
• Saving into the configuration files the configuration parame-

ters modified through the CLI. 

There are a few commands hidden from the end-user to support the 
test utilities offered by AWare and Pocket AWare software applica-
tions. Another set of hidden CLI commands is intended to facilitate 
the unit’s troubleshooting in production and repair centers. 

8.2.1 COMMAND LINE INTERFACE CONVENTION 

The following convention is implemented in AlphaWave Command 
Line Interface (CLI): 
 

• An error in the command will be replied by a list of available 
commands (see also section 4.2.2). 

• An error in the in the command’s parameters will be replied 
by a command usage. 

• A command followed by “/?” will display a command usage. 
• A command with the certain [Parameter Name] and blank 

[Parameter List] will display the current settings for a given 
parameter. 

 
A command with the blank [Parameter Name] and [Parameter List] 
will display the current settings for all parameters. 
 

Note:  The unit’s configuration that is set or modified through the 
CLI will be lost after unit’s reboot, unless the saving opera-
tion is used to store a new setting in the unit’s configura-
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8.3 “AWARE” CONFIGURATION SOFTWARE 

“AWare” is a software application running on an external PC in Win-
dows 98/ME/2000/NT/XP environment that provides sophisticated 
and complete solution for remote and local configuration, perform-
ance monitoring and diagnostics. It allows the Network Administrator 
to organize, manage, and control wireless connections built on AW. 
 
Refer to Chapter 3 for a detailed description of the “AWare” GUI. 

8.4 “POCKET AWARE” CONFIGURATION SOFTWARE 

“Pocket AWare” Windows-CE based software application, run on PDA 
(Personal Digital Assistant), will allow operators to configure and 
maintain the AW radio units. 

Refer to Chapter 3 for a detailed description of the “AWare” GUI 
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A-1 Alpha-Wave Environmental Specifications 

 

Parameter Specification 

Temperature 
Operating –30oc to +60oc (ETSI 300-019-1-3 Class 3.1
(E)) 
Storage –40oc to +80oc 

Solar radiation 1000 w/m2 at +40oc 
Vibration without Transporta-
tion Case 
  

10 to 500 Hz; ± 0.35 mm, 5 cycles, 1 octave/
min within operating temperature range 
(ISO 9022-36-08) 

Bump 
  

25g, 6 ms, 4000 shocks in each direction and 
axis within operating temperature range 
ISO9022-31-06 @ operating temperature min./max. 

Drop without Transportation 
Case 
  

1.5 m once to all surfaces on to hardwood (50 
mm) over concrete floor within operating tem-
perature range 

Water, Sand, and Dust 
Meets or exceeds the stan-
dard outlined in IEC 529 I.P. 
67 (water-tight and dust-tight). 

Rain: MIL506.4-I 
Submersion: MIL512.4-I 
Dust: MIL510.4-I 

Humidity 
(MIL-STD-810F Method 507.4-1) 
  

Min 5 cycles/1 cycle = 48h 
Max 60oC, max. RH 95% operating 
Max 65oC, RH 95%, 65h (none operating) 

Altitude -1,000m under sea level to 8,500 m above sea 
level 

Compliance to IEC61000-4:   
Radiated, radio frequency, 

electromagnetic field immu-
nity 

IEC61000-4-3 Level 3 

Immunity to the conducted 
disturbances induced by RF 

field 
IEC61000-4-6 Level 3 

Power frequency magnetic 
field immunity IEC61000-4-8 Level 4 

Electrostatic discharge 
(contact and air discharge) 

IEC61000-4-2 Level 4 

Electronic Compliance   
ETSI ETSI 300-113 
FCC FCC Part 15 

Industry Canada RSS-210 
UL UL 1419 

UL Hazardous Location Class 1, Div 2; Groups A, B, C, and D; hazard-
ous locations 

FM Approved 
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 A-2 Transmitter Specifications 

 
A-3 Receiver Specifications 

Parameter Specification 

Output Power 13 dBm to 33 dBm in 1 dB steps 

Output Power Control Accu-
racy 

±1.5 dB (at normal test conditions) 
+2.0 dB and -3.0 dB (under extreme test condi-
tions) 

Nominal Output Impedance 50 Ohms  

Carrier Frequency Stability ±1.5 ppm initial stability over temp with ±3 ppm 
aging/year 

Max. Frequency Error ±1.0 kHz (at normal test conditions) 
±1.5 kHz (under extreme test conditions) 

Adjacent Channel Power 
(Conducted) 

25 kHz CS 12.5 kHz CS 6.25 kHz CS 
70 dBc 60 dBc 50 dBc 

Spurious Emission 
(Conducted) 

-36 dBm @(9 kHz – 1 GHz) 
-30 dBm @(1 GHz – 4 GHz) 

Spurious Emission 
(Radiated) 

-36 dBm @(9 kHz – 1 GHz) 
-30 dBm @(1 GHz – 4 GHz) 

Compliance FCC Part 15 
ETSI EN 300-113 

Parameter Specification 

Noise Figure 10 dB 
Nominal Input Im-
pedance 50 Ohms 

Dynamic Range -119 to -52 dBm 
Max. Input Signal 
Level -10 dBm 

  25 kHz  
CS 

12.5 kHz 
CS 

6.25 kHz 
CS 

Receiver Sensitivity 
for DBPSK 
(@ BER 1x 10-4, 
over temperature –
30oC to +60oC) 

-113 dBm -116 dBm -119 dBm 

Co-channel Rejec-
tion -8 dB -12 dB -16 dB 
Adjacent Channel 
Selectivity 70 dBc 60 dBc 50 dBc 
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The built-in user-friendly Command Line Interface (CLI) allows the 
user to perform a full configuration of the unit and read the statistics 
and alarm status. It is the most powerful tool to configure the unit. 
It makes changes to all possible settings that system will not be able 
to determine automatically.  
 
The CLI commands allow a user to configure and reconfigure the 
unit’s settings. The user configuration parameters that can be 
changed through the CLI are: 
 

• Data Port Settings 
− Baud Rate 
− Data Bits (8, 7) 
− Parity (Odd, Even, None) 
− Flow control (None, RTS/CTS, XON/XOFF) 

• Alarm Settings 
• Radio Operation Modes 
• Sleep modes 

− On/Off 
− Activate by internal real-time clock 
− Activate through RTS/CTS lines 
− Activate by external sense lines 
− Activate by any combination of the parameters men-

tioned before 

 
The CLI commands also provide filing operations, which include: 

• Downloading 
− Unit’s Configuration files 
− Software Images 

• Uploading Unit’s Configuration files 
• Saving into the configuration files the configuration parame-

ters modified through the CLI. 

There are a few commands hidden from the end-user to support the 
test utilities offered by AWare and Pocket AWare software applica-
tions. Another set of hidden CLI commands is intended to facilitate 
the unit’s troubleshooting in production and repair centers. 

 

Note:  The unit’s configuration that is set or modified through the 
CLI will be lost after unit’s reboot, unless the saving opera-
tion is used to store a new setting in the unit’s configura-

A
pp

en
di

x 
B

 



AlphaWave Users Manual                                    3/21/2005 

           Page B-3 

B.1 CONVENTION 

The following convention is implemented in the Alpha-Wave Com-
mand Line Interface (CLI): 
 

• The Carriage Return/Line Feed (CR/LF, 0x0D/0x0A) is a com-
mand delimiter. 

• The Carriage Return/Line Feed (CR/LF, 0x0D/0x0A) followed 
by the “CLI> ” prompt is a reply delimiter. 

• An error in the command is replied by a list of available com-
mands (see also section 0). 

• An error in the in the command’s parameters is replied by a 
command usage. 

• A command followed by “/?” displays a command usage. 
• A command with the certain [Parameter Name] and blank 

[Parameter List] displays the current settings for a given pa-
rameter. 

• A command with the blank [Parameter Name] and 
[Parameter List] displays the current settings for all parame-
ters. 

B.2  HELP 

The HELP command types the list of all available commands: 
AW Radio 
Command Line Interface 
 

 
 

LINK  RF Link Operation Mode 
FREQ  Frequency Assignment 
DPORT Data Port Configuration 
MPORT Maintenance Port Configuration 
ALARM Alarm Indication and Alarm Control Configuration 
SLEEP Sleep Mode Configuration 
CONNECT Managed Unit Connection 
XMOD  X-Modem mode 
STATE Display Status and Statistics 
EVENT Display List of Events 
BOOT Reboot the unit 
SAVE Save Current Configuration into Configuration File 
[COMMAND] /? Display Command Usage 
HELP  Display this usage 
Figure B-1: Command Line Interface Usages 
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B.3  LINK 

The LINK command is responsible for configuring radio’s operation 
mode. It has six parameters listed below. 
 

LINK [Parameter Name] [Parameters List] [/?] 

 

 
 

Parameter 
Name Parameter List 

PROT 

1 – Simplex “Receiver” 
2 – Simplex “Transmitter” 
3 – “Repeater” 
4 – Secondary “Transceiver” (default) 
5 – Primary “Transceiver” 
6 – Full duplex 

DELAY 
0 – No Delay (default) 
The delay (1 – 7) is required delivering the data to the destination 
receiver. The number of repeaters in the chain defines this value. 

MOD 
1 – DBPSK 
2 – DQPSK (default for AW) 
3 – D8PSK 
4 – 16QAM 

PWRB / 
PWRW (13 – 33) / (20 – 2000) – RF output Power in dBm / mW 

CHAN 
Selects the frequency channel, CN = (1 – 32). The maximal value 
is defined by number of frequencies in the channel list. The CN = 0 
is reserved to set the Frequency Automatic scanning mode. 

FHOP (1 – 128) – Frequency Hoping Pattern number 

SCRAM 0 – No Scrambling (default) 
(1 – 255) – Seed for Pseudo-Random Sequence Generator 

ENROL 
Enrolls the secondary units into the wireless cluster. The enrolled 
unit’s 6-digit serial numbers are delimited by commas SN1, SN2, 
SN3 ... SN31, SN32. The number of units in the cluster does not ex-
ceed 32. 

FEC 0 – Disable Forward Error Correction (FEC) 
1 – Enable Reed-Solomon encoding 

ARQ 0 – Disable ARQ 
(1 – 8) – Number of Requests 

Note: The frequency defined by CHAN parameter is not valid if 
 Frequency Hopping mode is selected. 

  In the Frequency Hoping mode, the Frequency Pattern gen-
 erator must generate random numbers smaller than the 
 number of frequencies listed in the unit’s frequency list. 

 The ENROL parameter is not valid if the “Receiver” protocol 
 is selected  
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B.4  DPORT 

The PORT is an object that responsible for data port interface con-
figurations like Bit Rate, Flow Control, etc. 
 

PORT [Parameter Name] [Parameters List] [/?] 

 

B.5  MPORT 

The PORT is an object that responsible for data port interface con-
figurations like Bit Rate, Flow Control, etc. 
 

PORT [Parameter Name] [Parameters List] [/?] 

 

B.6  ALARM 

The ALARM command is intended to set up the alarm indication 
mode and alarm control lines’ behavior. 
 

ALARM [Parameter Name] [Parameters List] [/?] 

Parameter Parameter List 

RATE 0 – Maintenance Port baud rate 
Others – Set or retrieve data port’s baud rate 

BITS Set number of bits in one byte (8 or 7) 

PARITY 
0 – None 
1 – Odd 
2 – Even 

FLOW 
0 – None 
1 – SW (XON/XOFF) 
2 – HW (RTS/CTS) 

Parameter 
Name Parameter List 

RATE 0 – Auto. 
Others – Set or retrieve maintenance port’s baud rate 

BITS Set number of bits in one byte (8 or 7) 
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The Alarm LED must indicate the SYNC Loss and BER exceeding the 
defined threshold. 

B.7  SLEEP 

The SLEEP command determines the sleep mode parameters. The 
sleeping AW can be activated by real-time CLK, DTR/RTS lines, and 
command received through TTL inputs. The user can select one, two, 
or all three conditions. 
 

SLEEP [Parameter Name] [Parameters List] [/?] 

 

B.8  CONNECT 

To connect the radio unit (local or remote) through the local mainte-
nance serial port, the CONNECT command must be used. 
 
CONNECT [Unit_Numb] [/?] 
 
Where the Unit_Numb is an assigned decimal number for the unit to 

Parameter 
Name Parameter List 

TTL1 

0 – TTL_OUT1 = logic “1” 
1 – TTL_OUT1 = TTL_IN1 (received from remote unit) 
2 – TTL_OUT1 = TTL_IN1 and TTL_IN2 (received from remote 
unit) 
3 – TTL_OUT1 = TTL_IN1 or TTL_IN2 (received from remote unit) 

TTL2 
0 – TTL_OUT2 = logic “1” 
1 – TTL_OUT2 = TTL_IN2 (received from remote unit) 
2 – TTL_OUT2 = SYNC Loss 
3 – TTL_OUT2 = BER > BERTH or SYNC Loss 

BERTH 1 – BER  Threshold >10 –3 (default threshold level for BER) 
2 – BER  Threshold BER >10 –4 

Parameter 
Name Parameters List 

CLK 
0 – Do not activate by internal real-time clock 
(1 – 255) – Activate by internal real-time clock after 100 to 25500 
msec of sleeping 

HW 0 – Do not activate through DTR/RTS lines 
1 – Activate through DTR/RTS lines 

TTL 0 – Do not activate by external sense lines 
1 – Activate by external sense lines 

GTS 
0 – Disable Sleep mode (default) 
(1 – 255) – Go to sleep mode if there is no activity in 10 to 2550 
msec 
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be connected. To get the complete unit list, the CONNECT command 
must be used with no parameter. The list of units in the Point-to-
Point link with established connection with a remote unit is shown in 
Figure B-2:    

        

 
 
Where the Product column show the factory configuration number 
loaded into the unit and Serial Number column shows its unique se-
rial umber.   
To connect to the local unit, the parameter (Unit_Numb) must be 
equal to 1. 

B.9  XMOD 

The XMOD command activates the X-Modem mode that is used by 
system operator to load a factory configuration or update a firmware 
image. 
 
XMOD [Loading] [/?] 
 
The Loading specifies a file being loaded: 
 

• IMAGE – intended to load an updated firmware image (can be 
used in the field by end-user); 

• FACTIMG – intended to load a factory firmware image (hidden 
command used only in production); 

• DFCFG – intended to load a factory configuration (hidden 
command used only in production); 

• CFGUP – intended to upload the radio configuration, which 
includes the factory and user-defined configuration (hidden 
command used by AWare application only); 

• CFGDN – intended to download the radio user configuration 
(hidden command used by AWare application only). 

 

Unit Product Serial Number Connect 

1 UK00425 003578659922   

2 UK00425 003574459923       C 

Figure B-2:  Connection List 
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B.10  STATE 

The STATE command is used to check the state of the wireless link, 
the unit in the link, and the alarm control lines. To specify a radio 
unit (local or remote), the CONNECT command must be used in prior 
of STATE command using. 
 

STATE [Parameter Name] [Parameters List] [/?] 

 
 
The STATE command without Parameter Name indicates all values 
as shown in Figure B-3: 
 

 

 

 

 

Note: To activate a newly loaded firmware image and conf
 iguration, the unit must be rebooted (see also Section 
 6.4.3). 

Parameter Name Parameters List 

TTL1 0/1 – State of TTL_IN1 line 

TTL2 0/1 – State of TTL_IN2 line 

RSSI -52 to -116 dBm – Indicates the Receive Signal Strength in 
dBm 

BER 10 –8 to 10 –3 – Indicates the BER level 
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TTL_IN1 = 0  
TTL_IN2 = 1  
RSSI = -110 dBm  
BER < E-5  

Figure B-3: STATE Command Display 
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B.11  EVENT 

The AW unit records the events in the event log, which is 100 events 
deep. The events in the log are identified by a unique event code. 
 
The EVENT command is intended to read the log of events from the 
unit. The unit responses to the EVENT command by sending the 
event codes consecutively in order of occurrence. 

B.12  BOOT 

The BOOT command is intended to reboot the unit using the factory 
and user selectable configurations for system initialization. A new 
unit will have the default values for user selectable parameters that 
should be loaded in production. 
 
The BOOT command also selects the real-time software/ firmware 
image. The software loader after reboot runs the image selected by 
BOOT command. The factory firmware image will be used if the up-
dated firmware is not loaded or if it is corrupted or has any other 
problem. 
 
BOOT [Image] [/?] 
 
The Image specifies a selected real-time software image: 

∗ FACT – selects the real-time software/firmware image; 
∗ UPDT – selects the user updated real-time software/firmware 

image. 

B.13  SAVE 

The SAVE command is intended to store the unit’s currently used 
configuration into the User Configuration file. The configuration 
stored in the User Configuration file will be activated by automati-
cally after unit’s reboot. 
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